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Please note:  This guide is not meant to be comprehensive but a quick start to using UI 1.0.  For 
a more complete look at all the features, refer to Datatel’s Guide to User Interface 1.0. 
 
Legalese:  This guide is adapted from Datatel’s Guide to User Interface 1.0 and from Technology 
Services’ Datatel documentation.  Any plagiarism is deliberate. 
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Logging In 
 
 
Locate the Datatel UI icon on your desktop. 
 

Double click the Icon.   
 
Alternately, you can access UI from the Datatel menu under Programs in the Windows 
Start menu. 
 
The Datatel Login dialog box is displayed.   
 

  
 
 
 

� Enter your User ID.  This is typically your last name, followed by your first initial 
and is limited to 8 characters.  In the example above, Jane Doe’s User ID is doej.   

 
� Enter your password.  Your password must contain both numbers and letters and 

must be between 6 and 8 characters. 
 

� Select the database you want from the drop down list. 
 

� Click OK. 
 
A dialog box stating that User Interface 1.0 is loading application files will appear.  
When it has finished loading the files, the application workspace will appear. 
 

 
 
 
 
 

Pull down 
to view 
accounts 
available 
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Application Workspace 
 
 
 
 

 
 

 
Application Workspace Overview 
 
The application workspace is the container for all processes in Colleague. 
 
The left panel of the application workspace displays the folders and processes available 
for the selected application in expandable tree format. 
 
Navigating the workspace. 
 

� Click the Plus sign next to any folder icon in the left panel to expand the folder. 
� When a folder is expanded, you can click the Minus sign next to its icon to 

collapse it.  Double-click a folder icon in either panel to expand the folder.  
� Double-click a form icon in either panel to open the form. 
� When a form is open, it is displayed in the right panel. 

Toolbar Menu Bar Title Bar 
Address Bar 

Tree Menu Panel 
Contents of the 
Folder That Is 
Currently Selected 
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� You can choose to have the left panel of the application workspace remain visible 
(default condition), or hide it in order to allocate more space for the form. 

� When no form is open, the right panel displays the contents of the folder that is 
currently selected. 

 
 
Toolbar 
 
The toolbar provides easy access to common functions, such as saving your work, 
canceling changes, deleting records, and accessing online help. 
 
 
 
 

 
 
 

The Save All  and Cancel All  buttons and the corresponding File drop-down 
menu options enable you to save or cancel all of your changes simultaneously to every 
screen that is currently open. 

Note:  The Record Delete button  is used to delete an entire record, and only works 
for forms that have been defined to allow this option.  When you click this button, you 
are prompted to confirm that you wish to delete the entire record. 
 
 
Application 
 
Application determines which modules and forms (screens) you can access.  The current 
database and application is displayed in the title bar. 
 
 
 
 

 
  
 
In this example, the application is the Student Application, ST and the account is coltest.  
To change to another application, select Apps from the menu and click the appropriate 
mnemonic. 

Current 
account 

Current 
application 

Exit 

Record 
Delete 
 

Field Help 

Cancel Save Hide/Show Tree Menu 

Save All Cancel All 
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Types of forms 
 
The type of icon identifies the type of form. 
 

  Maintenance – Allows you to enter and change data.  If your database administrator 
has given you have read-only access, you will be allowed to view the form in inquiry 
mode only.  The form will still display a maintenance icon. 
 

  Processing  - Starts a program that manipulates a record or group of records that 
operate behind the scenes.  An example of this would be posting a group of records to the 
General Ledger.  
   

   Inquiry – View information without changing it.  Inquiry forms are forms that are 
designed to display information without allowing changes to that information.   
 

   Report  - Generate reports.  A form allows you to input specifications before running 
the report. 
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Forms  
 
 
 
 

 
 
 
Form Overview  
 
Forms are where most of your work is done in Colleague.   With previous user interfaces 
to Colleague, forms were called screens. 
 
When a form is open it will display in the right panel of the application workspace, with 
its name and mnemonic displayed on a tab.  You can allocate more viewing space to the 

form by clicking the Tree  icon on the toolbar or choosing Hide Tree Menu from the 
Edit menu.  This will close the left tree menu panel and allow the form to occupy the 
entire application workspace. Click the Tree icon again or choose Hide Tree Menu from 
the Edit menu again to toggle this option off and display the tree menu in the left panel. 
 
Depending on your monitor size, resolution and font size, scroll bars may be necessary to 
view the entire form. 
 

 Form Name  Form Mnemonic 
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UI offers several additional features in the form of control buttons that assist you in 
viewing and editing data 
 

 Detail button – Open another form for more detail on this field. 
 

 Date/Calendar button – Select a date from the calendar browser for this field. 
 

 Calculator button – calculate a value for this field 
 

 Scroll buttons – access multiple values for this field 
 

 Window Operation button – allows you to insert or delete a row of data.  When 
you click this button, a dialog box appears. 

 
 
Click Insert to insert a new row above the current row. 
Click Delete to delete the current row. 
Click Cancel to leave the row unchanged and return to editing. 
 

 Drop-Down Edit button – Access a list of available codes for this field. 
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Validated Fields 
 
With fields that are code-driven, such as validated fields, you will notice that the code’s 
description disappears when you are entering data in the field. This is intentional. The 
code’s description returns as soon as you leave the field.  
 
Some code-validated fields use drop-down edit buttons to access their codes. 
 
Other fields are lookup fields.  When you select one of these fields, the word ‘LookUp’ 
will be displayed in the bottom left-hand corner of the form.  Instead of a drop-down box, 
use LookUp by entering  ‘…’ in the field and pressing the Enter key.  A resolution form 
will display and you can view the list of available values for this field. 
 

 
 

 
 
 
 
Record Groups   
 
A group is a set of related fields. Each field in a group can have multiple values. There 
are usually several fields in a group that are associated with each other in some way; 
these are often referred to as associated multivalues. Some sets of associated multivalues 
are presented as rows and some are presented as columns. 
 

 
 
 
 
 

 Group 
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Accessing Forms 
 
You can access forms in several ways. 
 

� Tree.  Use the tree menu to navigate through the folders. Once you have selected 
the appropriate top-level folder, you can expand it to locate the desired form. To 
select a folder or form in a tree menu, double-click it. 

 
� Address Bar.  Enter a form mnemonic in the address bar or use the drop-down list 

to select a previously used form mnemonic. Press Enter or click the Go button to 
display the form.  

 
 

� Favorites.  Use the Favorites drop-down menu to select a form that has been 
previously added to your list of favorites.   

 
 

� History List.  Click the File menu to display the mnemonics of the last ten forms 
you accessed, and select a form from the list. 

 
� Run Dialog Box.  Choose Run from the File menu or press Alt-F-R . The Envision 

Run dialog box appears, as shown in Figure 3-14. Enter the mnemonic of the form 
you want, click OK , and Benefactor or Colleague will display it. 
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Accessing Detail Forms 
 
When a field has a Detail button  next to it, you can access another form, called a detail 
form for more information about that item.  You can use one of the following two 
methods to access a detail form from a detail field: 

� Click the Detail button to the right of the field. 
� With the cursor in the detail field, choose Detail from the File menu. 

 
You will have more than one form open at once when you detail to another form.  The 
tab furthest to the right represents the active form. To ensure that each record is 
completed properly, only one form can be edited at a time. All forms below the current 
open form are inquiry only and do not allow input. Data on these forms is grayed out 
while another form is active.   
 
 
 

 
 
It is important to remember that when saving changes to a Detail Form, you must also 
save when exiting the preceding forms.  If you don’t save each form as you exit, all your 
changes will be lost. 
 
Shortcut: 

The Save All  and Cancel All  buttons and the corresponding File drop-down 
menu options enable you to save or cancel all of your changes simultaneously to every 
screen that is currently open. 
 
 
 
 
 
 
 
 
 

 ADSU is the active form  NAE can be viewed but not edited 
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Exiting a Form 
 
You can exit a form several ways – using the Toolbar, Menu or Function Keys. 
 

   Use the Save button to save your changes to a record.  This dialog box will display. 
 

 
 

Update – Save changes to the record and go to the lookup prompt. 
Cancel – Don’t save changes but exit record to the lookup prompt. 
Return – Go back to the record. 

 
 

   Use the Cancel button to cancel any changes you made to the current record.  This 
dialog box will display. 
 

 
 

Cancel – Don’t save changes but exit record to the lookup prompt. 
Return – Go back to the record. 
 
 

The Save All  and Cancel All  buttons will save or cancel all of your changes 
simultaneously to every screen that is currently open.  You will NOT be prompted the 
‘are you sure?’ dialog box.   If you canceled all by mistake, your changes are lost and if 
you saved all by mistake, your changes are committed. 

 
Other Ways to Exit a Form: 
  

File|Save or F10 key - then cancel or update or return – back to lookup prompt 
File|Cancel or Shift-F8 key - then cancel or update – back to lookup prompt 
File|Close or F9 key - then cancel or update or return – back to main window 
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Finding a Record - LookUps 
 
Once you have accessed a form, you will need to access the records you want to use with 
that form. You will be prompted with a dialog box to enter lookup information. 
 

 
 
With the Person LookUp, you need to enter information that identifies the person you are 
looking for.   There are several methods to look up a person. 
 

� Datatel ID – Each person is automatically assigned a 7-digit id.  If you have this 
number, it is the easiest way to locate that person.  Leading zeros are not 
necessary. 

 
� Social Security Number – Do not enter any dashes or spaces. 

 
� Full Name – Enter Last name, First name. 

 
� Partial Name – Enter any portion of the name, using at least two characters. 

 
 
Enter the look up information in the lookup dialog box and click the OK button. 
 
Social Security Number 

 
 
Full Name 

 
 
 
 
 



 16

Partial Name 

 
 
If you entered the Datatel ID or social security number for your lookup, the form you are 
trying to access will appear and the fields will be populated with the information from 
that person’s record. 
 
If you used a name lookup, a resolution form will appear that lists all the possible 
matches for the lookup criteria you entered. 
 

 
 
The resolution form will show a variety of information for each record, including name, 
address and social security number.  You can tell if the record listed belongs to a student 
by looking at the ‘Where Used’ field (second column, third line).  If they are in the 
students file, STU will be listed here. 
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If the resolution form is showing numerous matches, you can limit the matches to 
individuals (eliminating institutions) by typing a ‘V’ in the box. 

 
 
Then enter a ‘2’ for individuals. 

 
 
 
The resolution form will reappear with fewer matches. 

� If you do not want to select any of the matches found, click the Cancel button 

 at the bottom of the screen. 
 

� To select a record, click in the white box beside the desired record and click the 

Save button  on the bottom of the resolution screen.   Or, enter the number 
beside the record you want and type it in the white box at the bottom of the screen 
and press the enter key. 

 
Once you have selected a record, the form will load with the record for the selected 
person. 
 

Shortcut:  At the lookup prompt, enter @ to bring up the last record you accessed. 
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Add to Favorites 
 
You can make a customized list of frequently used forms by adding them to Favorites on 
the menu bar.   
 
Select the form you want to add to favorites by clicking the right mouse button.  Click the 
Add to Favorites pop-up. 

 
 
 
The Enter a Mnemonic dialog box is displayed with the mnemonic for the selected form 
filled in.  Click the OK button to add the form to your customized Favorites list. If you 
use folders to organize your Favorites, you can click the Create in button to select an 
existing folder or create a new folder for the shortcut. 
 

 
 
 
Now you can access the form you just added from the Favorites option on the menu bar. 
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Query Builder 
 
Use Query Builder to build queries that utilize UniQuery, the query language for the 
Colleague database. 
 
Query Builder has two new features with UI: 

� Set Default 
� Report Viewer 

 

 
The Set Default button allows you to make the directory location of your choice the 
default location to open queries from and save queries to.  Any query text that is in the 
Query Builder form when you click the Set Default button will become part of your new 
default parameters.  When you click the Clear button, those parameters are loaded. 
 
 

 
 
To use the Report Viewer, select it from the Output To section.  When you click the OK  
button to run your query, a File Import Monitor dialog box will show briefly before the 
Report Viewer displays your data. 
 

 
 

� Select Edit|Select All from the menu to copy all data or highlight a subset of data 
with your mouse and select Edit|Copy. 

� From the Edit drop-down menu, select Copy to Excel, Word, HTML Editor or 
HTML Browser to import the data. 
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Datatel Terminology 
 
Application-Main subdivision of Colleague, a set of modules grouped together to meet 
the needs of a broad functional area. Each module resides in one of four applications: HR 
(Human Resources), CF (Financials), CORE (Demographic Information), ST (Student) 
 
Databases-Datatel provides several different databases.  Each database uses the same 
programs, but contains a different set of data.  Before logging in, you should determine 
which database you need to use.  You will have access to two different databases: coltest 
(A test database, we use this one to determine what our processes will be), collive (The 
real information). 
 
Colleague- Datatel’s integrated software suite written for higher education for 
administrative processes. 
 
Frontview-Provides the user with a full graphical user interface. 
 
Mnemonic- 3 or 4 character code that stands for a form name. 
 
Module- Grouping of mnemonics into categories.  Each module corresponds to a specific 
functional area such as Registration, Academic Records, or Accounts Receivable. 
 
User Interface 1.0-Replaces Frontview as the graphical user interface to access 
Colleague. 
 
 
Useful Info 
 
Changing Your Password 
 

� Access the Change Password function-XPWD. 
� Enter login password:  Enter your current password, not the new password that 

you want to create. 
� New Password:  Enter what you want your new password to be.  Nothing will 

show on the screen. (use at least 6 characters, combination of letters and numbers) 
� Re-enter new password:  Enter new password again. 

 
 
Helpful Hints 

 
F9 Close this form. 
F10 Return to the lookup prompt for this form. 
@ Use at a lookup prompt will retrieve the last record accessed for the current form. 
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Common Forms 
 
XPWD-Change Password 
NAE-Name and Address Entry  (details to ADSU) 
ADSU-Address Summary 
 
 
Lookups 
 
Hints for a lookup on the Person file: 

� SSN- Type in the number, no spaces or dashes 123456789 
� Full, Name- Last name, First name   jones, susan 
� Partial name-Any portion of the name, must be at least 3 characters    jon… 

 
 
Problems logging in? 
 

� Make sure you are logging into the correct database. 
� Login name and password must be in lower case. 
� Computer must be connected to the campus network. 
� If you cannot access a form, make sure you are in the correct application. 

 
Who To Call 
 
Technical Problems-Help Desk                                                          760-2323 
Datatel-specific Technical Problems-Information Systems Help   760-8989 
Questions about student data- Registrar’s Office                         760-8593 


